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Important Safety Information
Carefully read the following safety
information before installing or operating the
equipment. Failure to follow these safety
warnings could result in damage to your
ionization system and/or voiding the product
warranty.




Use proper input voltage to avoid damaging the unit.



Never power-down an emitter by removing the cables, as this
can result in damage to the ionizer.



Do not clean emitter points while unit is powered. Doing so
may result in additional contamination and possible shock.



To avoid personal injury or damage to the equipment, perform
only the installation and maintenance procedures contained in
this manual.



Ensure that ground input to the Interface Module is a known
ground (not “common” from 24 VDC). Improper ground
connection may cause malfunction or component failure.

Verify that power to the controller and/or emitter is turned off
before connecting or removing emitters or cables. Failure to
do so may result in damage to the equipment.
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Wichtige Sicherheits-und Gebrauchshinweise
Lesen Sie aufmerksam die folgenden
Sicherheitshinweise vor der Installation oder
dem Betrieb des Gerätes. Nichtbeachtung
dieser Sicherheitshinweise, können zu
Schäden an Ihrem Ionisationssystem und /
oder zum Verlust von Garantie-Ansprüchen
führen.



Achten Sie auf die korrekte Versorgungsspannung, damit das
Gerät nicht beschädigt wird.



Stellen Sie sicher, dass die Stromversorgung zum
Steuergerät und / oder Emitter (Sender) vor dem Anschließen
oder Entfernen von Emittern oder Kabeln abgeschaltet wird.
Nichtbeachtung kann zu Schäden am Gerät führen.



Niemals einen Emitter durch Entfernen der Kabel abschalten.
Dadurch kann der Ionisator beschädigt werden.



Reinigen Sie keinesfalls Emitter-Punkte bei eingeschaltetem
Gerät. Andernfalls kann es zu zusätzlicher Verunreinigung
oder zu Stromschlag kommen.



Führen Sie zur Vermeidung von Verletzungen oder Schäden
am Gerät, nur die Installation und Wartung durch, wie sie in
diesem Handbuch enthalten sind.



Das Interface-Modul muss über Netz-Erde geerdet sein (nicht
über den Rückleiter der 24V Versorgung!). Unsachgemäße
Erdung kann eine Fehlfunktion oder Beschädigung von
Bauteilen hervorrufen

.
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1.1 About this Manual
This manual describes the system components of the AeroBar
Model 5225 Ionization System (AeroBar, Interface Module, and
IonMonitor software), and covers the following information:
• Installation and setup of system components, including
IonMonitor software
• Operation using the IonMonitor software interface
• Maintenance procedures
• Specifications for system components
• Warranty information
This manual covers the IM6T Interface Module version 1.X and
IonMonitor software version 1.0.X. It does not cover later
versions of the IM6T or IonMonitor. It does not cover the
integrated sensor. See Simco-Ion manual 19-5200-M-xx for the
version 3.0.X and later version products.
A Software Developer’s Kit (SDK) manual is also available, which
contains detailed information about the open-source code for
developing your own custom interface (Simco-Ion manual 195200IM6T-SW).
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1.2 System Overview
The AeroBar Model 5225 Ionization System is specially designed
for in-tool applications and mini-environments, where tight
integration with your system is a necessity.
The system is composed of:
• The Digital AeroBar Model 5225
• The Interface Module Model 5200-IM6T
• IonMonitor, Simco-Ion pre-compiled software routine or opensource code examples
The Interface Module Model 5200-IM6T powers the AeroBar.
System parameters are set and monitored using the IonMonitor
interface. A custom interface that is incorporated into tool programs
may be created based on the provided open-source code
examples.
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1.3 AeroBar Model 5225
Simco-Ion Digital AeroBar Model 5225 is a high-performance
ionizer specially designed for in-tool applications and minienvironments, with an aerodynamic design and cleanroomcompatible materials. Its high ion output provides fast neutralization
of electric charge on wafers, allowing charge to be reduced to
comply with E-78 Levels I and II, the recommended requirements
for semiconductor manufacturers.
The following AeroBar lengths are rounded to the nearest whole
number. For exact lengths, see Chapter 4, Specifications.
The AeroBar Model 5225 is available in five standard lengths:
• 22 inches (558 mm)
• 28 inches (711 mm)
• 44 inches (1118 mm)
• 64 inches (1626 mm)
• 84 inches (2134 mm)
Three lengths are also available with optimized placement of
emitter points over the FOUP openings for use in 300 mm EFEMs.
• 36 inches (907 mm)
• 56 inches (1412 mm)
• 76 inches (1918 mm)
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AeroBar Controls and Connectors

Figure 1. AeroBar Model 5225

1. Modular Port: A modular port on one end of the bar allows a
RJ-11 connection to the Interface Module and provides 24 VAC
to the bar.
2. Emitter Points: Emitters points are replaceable. The number
of points depend on the length of the bar.
3. Positive and Negative Ion Output Indicators: LEDs indicate
high voltage (HV) ionization. In Pulsed DC mode, lights flash
depending on which polarity has HV. Lights are continuously on
when in Steady State mode. Both positive and negative ion indicators and the Alarm LED flash once simultaneously during
communication.
4. Transmit and Receive LEDs: LEDs communicate with an
optional IR remote control. See Appendix B.
5. Alarm LED: LED flashes when the AeroBar is in alarm or
standby mode; also flashes once during communication with
the Interface Module.
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1.4 Interface Module Model
5200-IM6T
The Interface Module Model 5200-IM6T powers up to six AeroBars.
The Interface Module features an Ethernet port and an RS-232 port
for communication with process equipment or EFEM controllers.
Two versions of the the IM6T Interface Model are available:
• IM6T Version 1.X, described in this manual, runs with
IonMonitor Software Version 1.X and controls only ionizers.
The IM6T must be paired with the proper version of IonMonitor
Software in order to operate correctly. Older versions of the IM6T
can be factory upgraded to later versions if desired.
To determine what version of IM6T you have, look at the serial
number label on the outside of the product. If the model number
does not include the letters "NV" or "V3.X" or "V4.X" then it is
Version 1.X.
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Figure 2. Interface Module Model 5200-IM6T

1. RS-232 Port: One of two communication connection options.
An RS-232 cable connects from your process tool.
2. Ethernet Port: If connecting the Interface Module Model 5200IM6T directly to a PC, use a CAT-5 crossover cable. If the PC
connection is routed through a hub or router, use a regular CAT5 cable.
3. Handheld Remote Input: An RJ-11 cable connector is
reserved for future use.
4. Ionizer Connections (ports 1-6): RJ-11 cables connect up to
six AeroBars.
5. Additional and Future Connections (ports 5-6): RJ-11
cables may be used to connect AeroBars. Sensors are not
compatible with this version Interface Module. Do not attach
sensors.
6. Input Power 24 VDC: CPC-style connector for 24 VDC input
power equipment.
7. Power On/Off Rocker Switch (“Circuit Breaker”): Turns the
Interface Module on or off; resets the circuit breaker in the event
of a tripped breaker.
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8. Communication Indicators: Alarm, Comm, and Power On
• The red Alarm LED is not in use at this time.
• The yellow Comm LED indicates the Interface Module is
communicating with either the host (usually the process
tool controller) or connected AeroBars.
• The green Power On LED indicates that the Interface
Module is receiving power. It will blink if the output voltage
drops below 12 VAC.
9. Ground Connection: Provides additional ground.
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1.5 Ionization System Software
The AeroBar Model 5225 and Interface Module Model 5200-IM6T
are monitored and controlled using a graphical user interface (GUI),
IonMonitor. IonMonitor may be installed directly on a tool controller
or service engineer’s laptop, providing an integrated, softwarecontrolled ionization system.
This software package includes a collection of DLLs (dynamic link
libraries) and open-source code for IonMonitor, for developing a
custom monitoring and control application in Visual Basic, Visual
C++, Visual C#, or any COM-enabled development language. For
information about the developer’s kit, see the companion
developer’s kit manual, Simco-Ion part number 19-5200IM6T-SW.

Software Compatibility
IonMonitor version 1.X works with the IM6T Interface Module
version 1.X and all Model 5225 AeroBars. Simco-Ion also offers a
later version of IonMonitor software (version 3.X), which operates
with the enhanced IM6T version 3.X or 4.X, and includes the
capability of closed-loop control when combined with the Sensor
Model 5200-SR. IonMonitor software must be paired with its
proper version of IM6T Interface Module in order to operate
correctly.

Requirements
The software runs under either Microsoft® Windows XP or
Windows 7 operating systems. It places minimal demands on the
host system (typically less than 1% CPU usage). The system also
requires either a TCP/IP-Ethernet port or an RS-232 port on the tool
controller.
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Contents of the Software Package
The software package includes:
• IonMonitor.exe - IonMonitor graphical user interface (GUI)
program through which you can monitor and configure
AeroBars connected to an Interface Module. You can also
monitor and configure simulations of these devices when
IonMonitor is connected to the IonSimulator program.
• IonSimulator.exe - IonSimulator GUI that simulates the
behavior of an IM6T Interface Module with AeroBars attached
to its ports. The simulator supports hot swapping of ionizers in
ports, artificially delaying replies to iCON commands,
suppressing replies, automatic “wobbling” of AeroBar feedback
levels, and graphical editing of all ionizer settings including run
mode, op mode, emitter outputs, and so forth. There is also a
lightweight simulator named IonSimLite with a minimal
graphical user interface, intended primarily for performance
testing.
• IonAccess.DLL library - a collection of DLLs (dynamic link
libraries) and associated header files used to develop custom
monitoring and control applications in Visual Basic or Visual C/
C++. IonMonitor is built upon IonAccess.
• TestIonAccess.exe - a fully functional sample application,
written in C/C++, which demonstrates how the IonAccess
library can be used to integrate control and monitoring features
into your custom applications. This application is also used to
test the IonAccess library DLLs, hence its name TestIonAccess.
This application is provided in source code form for use as the
framework for your own control application.
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Safety Information
Before installing or operating any component
of the Digital AeroBar Ionization System,
carefully read the following safety
information:



Allow the Interface Module to run for 10 minutes before
adjusting any AeroBars.



After removing power from the AeroBar(s), allow a minute for
the high voltage power supplies to discharge.




Use proper input voltage to avoid damaging the unit.



Never power-down an AeroBar by removing the RJ-11 cable.
This may result in damage to the AeroBar.



Do not clean emitter points while the unit is powered. Doing so
may result in additional contamination and possible shock.



To avoid personal injury or damage to the equipment, perform
only the maintenance described in this manual.



Ensure that ground input to the Interface Module is a known
ground (not “common” from 24 VDC). Improper ground
connection may cause malfunction or component failure.

Do not connect or disconnect AeroBars to and from the Interface Module while the Interface Module is powered!
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Sicherheitshinweise
Vor Installation oder Betrieb von einem der
Bestandteile des Digital AeroBar
Ionisierungssystem, lesen Sie bitte sorgfältig
die folgenden Sicherheitshinweise:



Lassen Sie das Interface-Modul für 10 Minuten laufen, bevor
Einstellungen an AeroBars gemacht werden.



Warten Sie nach dem Trennen des/r Aerobars von der Spannungsversorgung eine Minute, damit sich die Hochspannungs-Netzteile entladen können.



Achten Sie auf die korrekte Versorgungsspannung, damit das
Gerät nicht beschädigt wird.



Verbinden oder trennen Sie Aerobars nicht mit bzw. vom
Interface-Modul während das Interface-Modul eingeschaltet
ist!



Niemals ein Aerobar durch Entfernen des RJ-11Kabel
abschalten. Nichtbeach-tung kann zu Schäden am Aerobar
führen.



Reinigen Sie keinesfalls Emitter-Punkte bei eingeschaltetem
Gerät. Andernfalls kann es zu zusätzlicher Verunreinigung
oder zu Stromschlag kommen.



Führen Sie zur Vermeidung von Verletzungen oder Schäden
am Gerät, nur die Installation und Wartung durch, wie sie in
diesem Handbuch enthalten sind.



Das Interface-Modul muss über Netz-Erde geerdet sein (nicht
über den Rückleiter der 24 V Versorgung!). Unsachgemäße
Erdung kann eine Fehlfunktion oder Beschädigung von
Bauteilen hervorrufen.
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2.1 Installation Guidelines
Keep in mind the following considerations when determining
locations for the units:
• Tool and mini-environment requirements/restrictions
• Access to controls
• Access to a regulated 24 VDC power supply within 10 feet (3m)
of the Interface Module
• Applicable SEMI standards
• Applicable National Electrical Code standards
• The least amount of distance for cables from the Interface
Module to AeroBars

Operating Environment
Do not operate any component of the AeroBar Ionization System in
corrosive or explosive environments. Operate the units in 60-95°F
(16-35°C) temperature, 40-65% relative humidity, non-condensing.

19-5225-M-01 Rev 2

14

19-5225-M-01 Rev 2

15

2.2 Ionizer Installation
Installation methods will vary, as all process equipment has
different requirements. Use the following general guidelines:
• Install AeroBars away from all moving components in the tool.
• Place AeroBars directly in the airflow from HEPA filters for
effective ionization discharge.
• Make sure that there are no obstructions in the airflow between
the AeroBar and the surfaces to be neutralized.
• Ensure there is unobstructed airflow over emitter points.
• Keep emitter points at least 4 inches (100 mm) from grounded
surfaces, including tool frames, skins, and other modules.
• Keep the AeroBars within a 12-36 inches (300-900 mm)
working distance from the wafers.
A bracket or hanging device may need to be constructed,
depending on your application. You may use clips (available from
Simco-Ion) to secure an AeroBar to a custom bracket. See the
Mounting section in this chapter.
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2.3 Interface Module Installation
Once an AeroBar is installed and wiring is prepared, install the
Interface Module Model 5200-IM6T and connect it to the AeroBar.

Electrical Requirements
Install the Interface Module within ten feet of a properly grounded
DC power supply receptacle. The power supply should provide 24
VDC (±2 VDC), minimum 1.0A.

Caution:

Use of improper input voltage may result in damage to the unit.
Verify that the Interface Module is receiving 24 VDC before
applying power to the unit.

Achtung:

Anschluss an ungeeignete Versorgungsspannung kann zu
Schäden am Gerät führen. Stellen Sie sicher, dass das
Interface-Modul mit 24 VDC versorgt wird, bevor das Gerät
eingeschaltet wird.

Grounding
Ensure that ground input to the Interface Module is a known ground
(not “common” from 24 VDC).
If a known ground connection is not available at the connector input,
connect a 22 AWG or heavier gauge cable between the side screw
on the IM6T Interface Module and known ground source as shown
in Figure 3.
Improper ground connection may cause malfunction or component
failure.
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Figure 3. Known ground connection (if none can be provided on connector input)

Warning:

Use of improper input voltage may result in damage to the unit.
Verify that the Interface Module is receiving 24 VDC before
applying power to the unit.
Make sure ground to the Interface Module is a known ground.
Improper ground connection may cause malfunction or
component failure, and may void the warranty.

Unsachgemäße Versorgungsspannung kann zu
Beschädigungen des Gerätes führen. Stellen Sie sicher, dass
das Interface-Modul mit 24 VDC versorgt wird, bevor das
Gerät eingeschaltet wird. Stellen Sie außerdem sicher, dass
Warnung:
das Interface-Modul zuverlässig über Netz-Erde geerdet ist.
Unsachgemäße Erdung kann Fehlfunktion oder
Beschädigung verursachen und zum Verlust von GarantieAnsprüchen führen.
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Mounting
The Interface Module may be mounted using the screw holes on the
bottom of the chassis or with self-adhesive dual-lock strips. For
safety considerations, the mounting systems used for the Interface
Module should be able to support approximately four times the
weight of the Interface Module (approximately 16 lb./6 kg).
For mounting with self-adhesive dual lock strips: Use three to
five self-adhesive dual lock strips.
For mounting with screws: The mounting location will determine
the type of screw to be used. If your installation is replacing an older
system, note any differences between the older controllers and the
Interface Module chassis.

19-5225-M-01 Rev 2
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2.4 Unit Connections
Connecting AeroBars to the Interface Module
Up to six AeroBars may be connected to the Interface Module, using
an RJ-11 plug style cable. (Ports 5 and 6 should not be used with
a Sensor; this version of the IM6T Interface Module does not
support the Sensor. Contact your sales representative for more
information of ioninfo@simco-ion.com.)
A 15-foot cable is supplied with the AeroBar. Different lengths of
pre-made cables are available for use with the AeroBar, but it may
be necessary to construct your own cable to allow for custom sizing.
See Figure 5 for custom cable information.

Figure 4. Five AeroBars Connected to Interface Module

Warning:

Verify that power to the Interface Module is turned off before
connecting or disconnecting AeroBars.

Warnung:

Stellen Sie sicher, dass das Interface-Modul mit 24 VDC
versorgt wird, bevor das Gerät eingeschaltet wird.
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Figure 5. Interconnect Cable Assembly for Custom Sizing

Power Connections
Connect 24 VDC input power to the Interface Module using a CPCstyle connector. A pre-made cable with CPC connector is available
from Simco-Ion (part number 33-1790-40). This cable features
color-coded pin designations: 1=green, 2=red, and 3=black.
If constructing your own cable, the pin assignments at the IM6T
chassis are:
Pin

Characteristics

1

ground

2

ground

3

+24 VDC

4

Unused

It is not necessary to use both grounds. If a known ground
connection is not available at the connector input, connect a 22
AWG or a heavier gauge cable between the side screw on the IM6T
Interface Module and known ground source as shown in Figure 3.
Improper ground connection may cause malfunction or component
failure.
19-5225-M-01 Rev 2
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Warning:

Use of improper input voltage may result in damage to the unit.
Verify that the Interface Module is receiving 24 VDC before
applying power to the unit.
Make sure ground to the Interface Module is a known ground.
Improper ground connection may cause malfunction or
component failure, and may void the warranty.

Unsachgemäße Versorgungsspannung kann zu
Beschädigungen des Gerätes führen. Stellen Sie sicher, dass
das Interface-Modul mit 24 VDC versorgt wird, bevor das
Gerät eingeschaltet wird. Stellen Sie außerdem sicher, dass
Warnung:
das Interface-Modul zuverlässig über Netz-Erde geerdet ist.
Unsachgemäße Erdung kann Fehlfunktion oder
Beschädigung verursachen und zum Verlust von GarantieAnsprüchen führen.

Figure 6. CPC-style Connector
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2.5 Communication Connections
There are two methods of connection to communication devices: by
Ethernet cable or by an RS-232 cable. Both connection types are
provided on the Interface Module.
The Interface Module may be connected via both RS-232 and
Ethernet cables simultaneously. However, in order to maintain the
integrity of the communication, simultaneous connections should
only be used for diagnostic purposes. Simco-Ion recommends
using one connection at a time. Unpredicatable results may occur if
both are used at once.

Ethernet Connection
Connect a CAT-5 cable to the ETHERNET port on the Interface
Module.

Figure 7. CAT-5 Cable Connected to Ethernet Port

If you are connecting to a hub or router, use standard Ethernet
cables. If you are connecting directly to another computer (such as
a laptop), a cross-over Ethernet cable is required.
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RS-232 Connection
Connect an RS-232 cable to the RS-232 port on the Interface
Module.

Figure 8. RS-232 Cable Connected to RS-232 Port
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2.6 System Power Up
Turn on the Interface Module and AeroBar with the rocker switch
labeled POWER.

Figure 9. Interface Module Power Switch

The green POWER ON LED will light. The yellow COMM LED will
also light as communication occurs between any connected
AeroBars and the Interface Module.

Warning:

Do not connect or disconnect AeroBars to and from the
Interface Module while the Interface Module is powered!

Verbinden oder trennen Sie Aerobars nicht mit bzw. vom
Warnung: Interface-Modul während das Interface-Modul eingeschaltet
ist!
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2.7 Alarm Test
Testing the alarm ensures that all units are communicating properly.
Test the alarm using the software interface. Without the software
interface, you can test the alarm manually using Simco-Ion infrared
Remote Control Model 5570.

Note:

The IM6T's alarm LED will not turn on if the IM6T is not set to
poll AeroBar, Default. To set the IM6T to automatically poll
AeroBar contact Simco-Ion for more information.

Hinweis:

Die IM6T's Alarm-LED leuchtet nicht wenn das IM6T nicht auf
Poll Aerobar, Default eingestellt ist. Kontaktieren Sie Ion
System für weitere Informationen wenn das IM6T auf
automatisches Poll Aerobar gesetzt werden soll.

The IM6T's alarm LED will not turn on. if the IM6T is not set to poll
AeroBar, Default. To set the IM6T to automatically poll AeroBar
contact Simco-Ion for more information."
To test the alarm:
1. Note the value of the positive feedback and negative feedback
settings.
2. Either change the positive alarm so that it is above the positive
feedback value or change the negative alarm so that it is above
the negative feedback level.

Note:

Changing the positive or negative output level automatically
resets the corresponding alarm level.

Hinweis:

Ändern der positiven oder negativen Ausgangspegel setzt die
entsprechende Alarm-Einstellung automatisch zurück.
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This sets the unit into alarm. If using the software interface,
check that it shows an alarm is occurring. Visually check that
the center LED on the bar blinks intermittently. If the unit is in
Pulse Mode the outer LEDs will alternate blinking. If the unit is
in Steady-state Mode both outer LEDs will remain lit.
Reset the alarm by changing the feedback value to the original
settings. Then reset the output to the desired level.
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2.8 IonMonitor Software Installation
Software Installation
To install the software, copy the file “Simco-Ion Release 1.X.X.exe”
in any convenient directory and run it. The default installation
directory is C:\Program Files\IonSoftware\.
The installer will place a new folder in your Start menu named
“IonSoftware” (you can select a different name during the
installation) with shortcuts to IonMonitor.exe, IonSimulator,
TestIonAccess.exe, API web-page documentation, and the
software manual.

Note:

If you only install partial components during the installation,
you can repeat the installation to install additional components
at a later time by re-running the installation program.

Hinweis:

Wenn Sie nur zum Teil Komponenten während der Installation
installieren, können Sie die Installation wiederholen um zu
einem späteren Zeitpunkt zusätzliche Komponenten mit
erneutem Ausführen des Installationsprogramms
einzubauen.

Uninstalling the Software
To uninstall all components, select the “Uninstall Ion Software” icon
from the Ion Software program group, or run the “Add/Remove
Programs” option in the Windows Control Panel.
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2.9 Software Configuration
In order for an independent computer to communicate with the
AeroBar Model 5225 system for demonstrations or other remote
setups, you must configure the IonMonitor software for the Interface
Module Model IM6T.
Communication setup involves:
• Adjusting network settings on a computer
• Adjusting network settings in the IonMonitor application
• Adjusting network settings in the IonSimulator application

Adjusting Network Settings on a Computer
1. On your PC, open the Control Panel
(usually under “Settings”).
2. Open the “Network and Dial-up Connections” (or “Network Connections”)
window.
3. Right click on Local Area Connection and
click Properties.
4. In the “Local Area Connection Properties”
(or “Windows Network Connection Properties”) window, click on Internet Protocol (TCP/IP) then click on
the Properties button.
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5. Once the “Internet Protocol (TCP/IP)
Properties” window opens, change the
option from Obtain an IP address automatically to Use the following IP
address.
Set the options under Use the
following IP address and Use the following DNS server
addresses to the following:
• IP: 192.168.0.100 (If there are multiple computers being
setup with static IPs, use a free IP address.)
• Subnet Mask: 255.255.255.0
6. Click OK, then OK or Close. Reboot you computer to allow
communication to reset.

Setting IP Addresses in the IonMonitor Application
Now that you’ve set the computer, you need to set the software to
correctly recognize the computer.
1. Start the IonMonitor application.
2. Log in with the following configuration
password: 1414222.
3. Click the Edit menu in the top menu bar
and select Options.
4. Connection Mode: If connecting using an Ethernet, make sure
the TCP/IP radio button is checked.
If connecting via RS-232 serial connection, check Serial Com
Port. Enter the serial com port number in the Port Number box
(i.e., com port 1will be entered as Port Number 1).

19-5225-M-01 Rev 2
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5. Enter the IP address:
192.168.0.111. (This IP
address is the factory default
address of the Interface
Module. Your installation’s IP
address installation may vary.)
6. Click the Write configuration
in the IonMonitor.cfg button.
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3
Operation
3.1 Getting Around in IonMonitor
3.2 Network Configuration
3.3 Logging In and Connecting
3.4 Configuring AeroBars
3.5 Editing IonMonitor Options
3.6 Balance Adjustment and System Calibration
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3.1 Getting Around in IonMonitor
The IonMonitor application provides a graphical user interface
(GUI) for monitoring and configuring the AeroBar and Interface
Module.

Figure 10. The IonMonitor interface

1. Connect/Disconnect from Interface Module button
2. Start/stop Automatic GUI Refresh Button: Allows IonMonitor
to refresh information at specified time intervals; see Appendix
B for information on changing intervals.
3. Refresh GUI Fully Now button: A full refresh is typically used
when automatic refreshing has been turned off.
4. Configuration Area: Grayed out when only monitoring
5. Ionizer Select Boxes: Check boxes to select one or more
ionizers at a time to make changes to.
6. Running/Standby Setting: Select Running or Standby to turn
power to the emitter points on or off. (AeroBars are still powered
and communicating, but without ionization.)
7. Settings: Set values for one or more ionizers in these boxes;
values correspond to column heading.
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8. Use Default Ionizer Values button: Click to restore all settings
to default values; see Appendix B for information on changing
the defaults.
9. Session History List Area: Displays as much or as little information as you need; see Appendix B for information on setting
the amount of information that appears.
10. Status Bar: Indicates current status of the software (Monitor/
Connected) and how often an auto refresh will take place (in
seconds).
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3.2 Network Configuration
See the “Network Configuration” section in Chapter 2: Installation
for information on setting the IonMonitor software to communicate
with your computer.
Communication setup involves:
• Adjusting network settings on a computer
• Adjusting network settings in the IonMonitor application
• Adjusting network settings in the IonSimulator application
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3.3 Logging In and Connecting
Types of Login
There are two levels of login: monitoring or configuration. In either
mode, any connected IM6T Interface Modules or ionizers are
continuously monitored. To change settings for the IM6T Interface
Module or ionizers, you must be in configuration mode.

Login Passwords
• Password 1010321 enables monitoring only.
• Password 1414222 enables field-service-level configuration in
addition to monitoring.
To switch from monitoring to configuration mode,
1. From the File menu, select Enable Configuration or Disable
Configuration.
2. If enabling the configuration mode, re-enter the configuration
password, 1414222.

Figure 11. Select Enable Configuration or Disable Configuration to Switch Modes
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Connect to Units
Connect using the Connect button at the upper left of the window.

Figure 12. Connect to IM6T Button

A successful connection will be indicated with a message in the
session history window #5 in Figure 10.
Once you are connected, the GUI will automatically refresh its
information every several seconds by calling the IonAccess DLL.
You can:
• You can change the refresh interval in Edit > Options.
• You can also suspend and resume automatic refreshes by
clicking the Stop/Resume Automatically Refreshing button next
to the Connect button.
• The Refresh GUI Fully Now button causes an immediate
refresh that also directs the DLL and the IM6T to examine all
ports for inserted or removed ionizers. By default, the IM6T
does this examination every 60 minutes anyway, but there may
be times when you want to force it, for example after adding/
changing and/or removing Ionizers from the ports.
The simulator supports hot swapping of ionizers in ports, artificially
delaying replies to iCON commands, suppressing replies,
automatic “wobbling” of AeroBar feedback levels, and graphical
editing of all ionizer settings including run mode, op mode, emitter
outputs, and so forth.
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3.4 Configuring AeroBars
In general, the following adjustments should be made in order to
fine-tune ionization performance in a new installation:
This information is also available as a Quick Start Guide. Contact
Simco-Ion for a copy.

Note:

Simco-Ion recommends allowing the Interface Module to run
for 10 minutes before adjusting AeroBars.

Hinweis:

Simco-Ion empfiehlt, vor dem Einstellen der Aerobars das
Interface-Modul 10 Minuten laufen zu lassen.

Setting the Ionization Mode (OpMode)
About Setting the Ionization Mode
The ionization mode (called OpMode in IonMonitor) designates the
method of ionization for an ionizer to operate in.
Pulsed DC mode is recommended for most process tool
envoironments. Pulsed DC provides fast decay times and should be
used unless large metal objects (such as a pre-aligner or
measurement tool) are within 12 inches (30 cm) of the AeroBar.
Steady-state DC mode is recommended when the distance
between the wafer and AeroBar is <12 inches (30 cm), or when
large metal objects are within 12 inches (30 cm) of the AeroBar.
Steady-state mode is also recommended when low swing voltages
are required for sensitive devices (i.e., <100V swings).
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Use Pulsed DC mode for:

Use Steady-state DC mode for:

Distances >12 inches (30 cm) between
AeroBar and wafer

Distances <12 inches (30 cm) between
AeroBar and wafer, or for sensitive devices
(<100V swings)

No large metal objects are within 12 inches
(30 cm) of AeroBar

Large metal objects are within 12 inches
(30 cm) of the AeroBar

Setting the Ionization Mode in IonMonitor
1. Select the ionizers either by
checking their Select boxes or by
clicking one or more ionizer rows
in the grid. The selected ionizer
will highlight in the grid.

When only one ionizer is selected, all of its settings will show
up in the box fields below the grid.
When two or more ionizers have been selected and they share
the same value, the box field will be filled in, as shown in the
screen shot below.
Note:

Two or more ionizers are selected and share a common value
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2. Use the drop-down box to
change the ionization mode for
the selected ionizer(s). Click
Apply Changes to accept.

Note:

When ionizers have been selected, you can click the Use
Default Ionizer Values button to revert all settings to the
defaults that are loaded from the startup configuration file. See
Appendix B: Setting IonMonitor Options for more
information.

Hinweis:

Wenn Ionisatoren ausgewählt wurden, können Sie die Use
Default Ionizer Values- Taste drücken um alle Einstellungen
auf die Standardeinstellungen (Defaults) aus dem Startup
Configuration File zurück zu setzen. Siehe auch Anhang B:
Einstellung IonMonitor Optionen für weitere Informationen.

Setting the Output Voltages
About Setting Output Voltages
The recommended typical output range is 50-80%.
For bars operating in Pulsed DC mode, adjust the positive and
negative output voltages so that the maximum swing values are
within 20V of each other, averaging a value as close to zero as
possible. The swings should not exceed 150V in either direction.
For bars operating in Steady-state DC mode, adjust the positive and
negative output voltages so that the combined value of the positiv
and negative settings are as close to zero as possible, and <±20V.
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For Pulsed DC mode:

For Steady-state DC mode:

Maximum swing values are within 20
volts of each other, averaging a
value as close to zero as possible.

The combined value of the positive and
negative settings are as close to zero
as possible, and less than ±20V.

Note:

If you modify a positive or negative output setting, then that
AeroBar will automatically modify its positive or negative alarm
to be approximately 1/4 (25%) of the new output setting. These
additional changes are not marked as pending, since you did
not make them yourself.

Setting Output Voltages in IonMonitor
It is important to set output voltages in coordination with
environmental readings you get during a balance adjustment. See
the Balance Adjustment section in this chapter.
1. Select the ionizer(s) either by checking the Select boxes or by
clicking one or more ionizer rows in the grid. The selected
ionizer will highlight in the grid.
2. Change the value in the boxes under the
PosOut or NegOut columns.
3. Click Apply Changes to accept.

Tip:

Editable text boxes - for example, positive output, negative
emitter off time, and alarm threshold settings - all display tooltip text with their units and valid ranges. Hold the mouse
pointer over a field to see this information.
Hold the cursor over a edit field to
see the range of values for that
parameter.
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Adjust the On- and Off-times (Pulsed DC Mode Only)
About Adjusting On- and Off-times
If the decay time is too slow and the voltage swings are less than
100V, increase both the positive and negative ontimes in 0.1
second increments, checking the positive and negative decay times
between each adjustment. When changes no longer positively
improve performance, set the ontime and offtime at the last
beneficial setting.
Adjusting On- and Off-times in IonMonitor
It is important to set positive and negative on or offtimes in
coordination with environmental readings you get during a balance
adjustment. See the Balance Adjustment section in this chapter.
1. Select the ionizer(s) either by checking the Select boxes or by
clicking one or more ionizer rows in the grid. The selected
ionizer will highlight in the grid.
2. Change the value in the boxes under the
PosOn, NegOn, PosOff, and NegOff
columns.
3. Click Apply Changes to accept.

Setting Positive/Negative Alarm Values
About Positive/Negative Alarm Values
Normally, alarm levels are automatically adjusted when the output
levels are set. The default alarm percentage value is 25%, which
means the alarm levels are automatically adjusted to 25% of the
output level. For proper maintenance and performance, alarm
percentage should be set to 50-75%.
Positive and negative alarm levels can also be changed individually,
without changing the output levels, as long as the alarm levels are
adjusted after the output levels have been set. In addition, note that
changing the positive or negative output level will cause the
corresponding alarm level to reset.

19-5225-M-01 Rev 2

43

Adjusting Alarm Values in IonMonitor
It is important to set alarm values in coordination with environmental
readings you get during a balance adjustment. See the Balance
Adjustment section in this chapter.
1. Select the ionizer(s) either by checking the
Select boxes or by clicking one or more
ionizer rows in the grid. The selected ionizer
will highlight in the grid.
2. Change the value in the boxes under the
PosAlrm and NegAlrm columns.3.Click
Apply Changes to accept.

Placing Ionizers in Standby Mode
About Standby Mode
Standby mode is a convenient way to turn off high voltage to the
ionizer without removing wires or accessing the Interface Module.
Standby mode is useful for maintenance periods where settings
must be remembered.
Placing Ionizers in Standby Mode
1. Select the ionizer(s) either by checking the Select boxes or by
clicking one or more ionizer rows in the grid. The selected
ionizer will highlight in the grid.
2. Use the drop-down box below
the list of ionizers to change
the mode from Running to
Standby.
3. Click Apply Changes to
accept.
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3.5 Editing IonMonitor Options
The following options may be adjusted and saved using the Options
menu in IonMonitor:
• Connection options
• Interface Module options
• Default ionizer settings
The settings in these three menus are saved to a setup
configuration file called “IonMonitor.cfg.”
For more information about this configuration file, including how to
change the settings in it, see Appendix B: Setting IonMonitor
Options.
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3.6 Balance Adjustment and System
Calibration
Simco-Ion balance adjustment and calibration procedure is a
regular part of installation and maintenance of the AeroBar and its
components. Adjustment for the AeroBar may be performed at
initial installation, during periodic checks of the entire system, or
anytime additional components are added to the system.
This section consists of the following information:
• About Adjustment and Calibration
• Tool parameters that Affect Ionization
• Performing the Adjustment
• Understanding Ionization Modes, Voltage Swing and Output,
and Decay Timing
• Troubleshooting
Goals of Balance Adjustment and System Calibration
• Balanced, high ion density arriving to the surfaces and wafers
• Similar positive and negative decay times
• Maximum decay in the amount of available time
• Moderate voltage swings (Pulsed DC) or voltage offset (Steadystate DC) to eliminate the possibility of inducing voltage on the
surfaces
Recommended Equipment:
• Charged Plate Monitor Model 280A
• Tripod (optional)
• Anemometer
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About Adjustment and Calibration
Environment variables and the physical properties of ions can lead
to degraded ionization performance over time. This leads to a
greater risk of static or the presence of voltage on your sensitive
product surface.
In order to ensure optimal ionization performance and therefore
static charge neutralization, ion delivery must be periodically
regulated, or balanced. This procedure is commonly referred to as
balance adjustment or system calibration.
Simco-Ion recommends performing a balance adjustment as part of
a regular maintenance program. In general, AeroBars should be
balanced every six months to a year. The actual frequency of
balance adjustment depends on the specific activity of your
application and environment.
In Pulsed DC mode, positive and negative ions are released
sequentially during ontimes. During offtimes, no ions are released
and existing ions disperse. In Steady-state DC mode, both positive
and negative ions are constantly produced. The goal of the
adjustment procedure is to regulate the ion delivery, so that equal
numbers of positive and negative ions arrive at the work surface to
neutralize static charges of either polarity in a specified amount of
time.
Adjustment of the AeroBar Ionziation System components may be
performed during periodic checks of the entire system.

Tool Parameters that Affect Ionization
Balancing involves adjusting positive and negative ionization output
levels and timing sequence of these outputs. You can make
adjustments to the AeroBar Model 5225 settings using the software.
In addition to the ionizer settings, be aware of the following variables
that can affect balance:
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• Airflow: he recommended airflow for effective ionization is 7090 fpm. Low airflow moves the ions more slowly, allowing
potential ion recombination and reducing the ions available to
neutralize surfaces. High airflow moves the ions in a more direct
path, reducing the surface coverage area.
• Configuration: Configuration changes differing from the
original spec (such as adding a pre-aligner or metrology tool)
may change the way the ions disperse. Also, metal objects
closer than 6 inches to the AeroBar will ground ions, reducing
the amount of ions available to the surfaces.
• Maintenance: Contaminants in the environment are attracted
to AeroBar emitter points. Dirty emitter points have an adverse
effect on ion output and voltage balance. As a general rule,
emitter points should be cleaned every 3 months, and AeroBars
should be rebalanced every 6 months to a year.
• Environment: Changes in cleanroom humidity and
background airflow may affect performance.
• Location: Specifications for the AeroBar location are based on
the designed-in location for AeroBars. Repositioning or
changing the mounting distance from the FFU will affect
performance results.

Performing the Adjustment
1. Choose a specification for the measurements.
If the facility has an existing specification for voltage swings and
decay times, obtain these numbers. If specs are not available or
do not exist, use the industry’s typical setting. (±50 to 100V for
semiconductor tools and mini-environments and ±100 to 150V
for wafer fabrication in open areas.)
A desired balance and decay time will depend on the sensitivity
of the product to electrostatic-related problems. Choose values
that meet the static charge protection needs of your environment; for example, the appropriate voltage swings range
decreases for products more sensitive to electrostatic-related
problems and increases for less sensitive products.
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If possible, set the AeroBar mode, outputs and timing to any
pre-determined settings for your process tool. If no settings are
available, use the following parameters for an optimization
starting point 50% Positive and Negative Power; 1.0 sec. ontimes; 0.2 sec. off-times.
2. Set the CPM in an appropriate location for obtaining
measurements: Remove the charge plate from the monitor
(refer to the charge plate monitor manual for instructions on
removing the plate, Simco-Ion P/N 19-0280-M or 19-280A-M).
For the AeroBar Model 5225, ideal locations include:
• Centralized in the mini environment chamber
• Next to a FOUP port
• On a pre-aligner
• On a metrology module
• On a buffer stations
After placing the CPM in its location, step away. Standing too close
to the CPM may interfere with airflow and ion movement. Make sure
all access doors are closed.
3. Record the Airflow: Use an anemometer to measure the
airflow at the height of the CPM plate. Record the air flow along
with the CPM measurements obtained at each sample location.
Too high or low of an airflow rate will affect the true balance
behavior of the ions. The recommended airflow for optimal
ionization is 70-90 fpm.
4. Take the measurements on the CPM: The measurements
taken on the CPM will record the following specifics:
• Positive and negative peak voltages
• Balance (an average of the positive and negative voltage
peaks)
• Positive and negative decay time
a) Allow the CPM to warm up for at least 15 minutes.
b) From the Main screen on the CPM:
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 Press Auto. The Auto test performs both Decay
tests, followed by a balance test.

 Make sure the symbol "D>" is next to the test you

want (usually the "Factory" test, which runs an auto
test with standardized test parameters).

 Press Start
c Note the numbers for +Vp (positive voltage peak), -Vp
(negative voltage peak), and Vave (average or balance).
5. Examine the Data and Adjust the AeroBars: If the measurements have been taken for an operation area do not meet your
specifications, use the software to adjust the AeroBar settings.

Understanding Ionization Modes, Voltage Swing and
Output, and Decay Timing
Ionization Modes
Ensure that the AeroBar is operating within the appropriate
ionization mode: Pulsed DC or Steady-state DC:
• Pulsed DC mode is recommended for most process tool
environments. Pulsed DC provides fast decay times and should
be used unless large metal objects (such as a pre-aligner or
measurement tool) are within 12 inches (30 cm) of the AeroBar.
• Steady-state DC mode is recommended when the distance
between the wafer and AeroBar is less than 12 inches (30 cm),
or when large metal objects are within 12 inches (30 cm) of the
AeroBar.
Voltage Swing and Output
Voltage swing refers to the range of the CPM plate voltage between
the positive and negative peak readings at sample locations.
The recommended typical voltage output range is 50-80%.
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• For Pulsed DC mode, adjust the positive and negative output
voltages so that the maximum swing values are within 20 volts
of each other--averaging a value as close to zero as possible.
The swings should not exceed 150 volts in either direction.
Keep the voltage swings below 100 volts if it is possible to meet
the desired decay time at this output level.
• For Steady-state DC mode, adjust the positive and negative
output voltages so that the combined value of the positive and
negative settings are as close to zero as possible and less than
±20V.
Decay Timing
Decay timing is a measure of the time (in seconds) that it takes to
decay a charge of +1000V to +100V, and -1000V to -100V. The
conductive plate is charged to the initial test voltage of 1000V and
is allowed to discharge to 10% of the initial test voltage. The time
required for both polarities will be recorded.
In Pulsed DC mode, if decay times are too slow and voltage swings
are >100V, increase the positive and negative offtimes in 0.1
second increments.
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Troubleshooting the Balancing Procedure
1. If decay times are too long, check that airflow is 70-90 fpm. If
airflow is too low and cannot be changed, see the table, Airflows
Are Lower Than Tool Specification and Cannot Be Changed:
For Pulsed DC mode:
•

•

For Steady-state DC mode:

If voltage swings are <100V, adjust + and ontimes upward in 0.1 second increments
until decay time stops improving or voltage
swings become too high. Maintain last
beneficial setting. Do not set below 0.7
seconds or alarms will be defeated. The
normal range is 0.7 to 2 seconds.
If voltage swings are >100V, adjust + and off-times upward in 1 second increments until
decay time stops improving or voltage swings
become too high. Maintain last beneficial
setting.

•

Increase the positive and negative
voltage outputs, maintaining a
balance of ±20V.

2. If voltage swings are too high (pulsed DC only):
If Voltage Outputs are >80%:
•

Decrease voltage outputs in 0.1%
increments, maintaining balance, until
swings are <100V or in desired range.
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Decrease positive or negative on- or
offtimes in 0.1% increments, maintaining
balance, until swings are <100V or in
desired range.

3. If airflows are lower than tool specification and cannot be
changed:
For Pulsed DC mode:
•

•

•

Increase voltage outputs in 1%
increments, maintaining balance until
swings reach 100-150V. Do not exceed
90% output. If decay times are still too
long, proceed to the next step.
Increase + and - ontimes in 0.1 second
increments, maintaining balance, until
decay time improves or voltage swings
become too high. Maintain last
beneficial setting.
Increase + and - offtimes in 0.1 second
increments, maintaining balance, until
performance stops improving. Maintain
last beneficial setting.
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Increase voltage outputs in 0.1%
increments, maintaining balance until
output reaches 90%.
If decay time is still too long, switch to
Pulsed DC mode and balance.
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4
Maintenance
4.1 Maintenance Power Down
4.2 AeroBar Maintenance
4.3 Interface Module Maintenance
4.4 System Adjustment and Calibration

Caution:

To avoid personal injury or damage to the equipment, do not
perform any maintenance other than that contained in these
instructions.
There are no user-serviceable parts inside the AeroBar or
Interface Module.

Vorsicht:

Zur Vermeidung von Verletzungen oder Schaeden am Geraet
duerfen keine Wartungsarbeiten ausgefuehrt werden, sofern
sie nicht in diesem Handbuch enthalten sind.
Es befinden sich keine Teile im AeroBar oder Interface-Modul,
welche vom Benutzer gewartet werden koennen.
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4.1 Maintenance Power Down
Before performing any maintenance, the AeroBar must be powered
down. There are two ways to power down AeroBars: turn off the
Interface Module, or place the AeroBar in standby mode.

Caution:

Never power-down an AeroBar by removing the RJ-11 cable,
as this can result in damage to the ionizer.

Achtung:

Niemals ein Aerobar durch Entfernen des RJ-11Kabel
abschalten. Nichtbeach-tung kann zu Schäden am Ionisator
führen.

Turning off the Interface Module is as simple as turning off the
power switch.

Figure 13. Interface Module Power Switch

To place the AeroBar(s) in standby mode using the integrated
software, see the accompanying software manual.
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4.2 AeroBar Maintenance
Primary maintenance for the AeroBar consists of periodic emitter
point cleaning and replacement, system calibration, and exterior
cleaning of the chassis. As maintenance schedules will vary
depending on conditions, develop a schedule which meets the
requirements for your application. In general, equipment should be
checked on a monthly basis to ensure it is operating as originally
set.
Emitter point cleaning is recommended every three to six months,
and replacement every 24 to 36 months or when damage or erosion
is evident. Calibration may be performed quarterly, semiannually, or
annually depending on your application. Always calibrate after
cleaning, since cleaning will throw off the calibration.
Where AeroBars are used in environments containing airborne
molecular contaminates (AMC), emitter points should be cleaned
every one to three months or wherever significant amounts of debris
have accumulated on emitter tips.

Figure 14. Eroded and Dirty Silicon Emitter Point Tip

Emitter Point Inspection
Emitter point maintenance ensures continued optimum
performance. Dirty or eroded points may cause system failure and
diminished ionization output. Dirt or erosion to emitter points can be
caused by a number of environmental factors, including AMC. It is
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important to create an inspection schedule for emitter points.
Schedules will vary depending on your environment.
Inspect emitter points for white fuzz or buildup on the tips, or tips
that are blackened or broken. Clean any buildup following the
procedures described below.

Emitter Point Cleaning
Recommended Cleaning Materials:
• Cleanroom-compatible cloth swabs (polyester cloth is
recommended)
• Cleaning solution of 50% IPA (electronic-grade isopropyl
alcohol)/50% de-ionized water or Simco-Ion Emitter Point
Cleaner (Simco-Ion part number #22-1000)

Caution:

Do not clean emitter points while the unit is powered. Doing so
may result in additional contamination and possible shock.
After powering down the AeroBar, allow a minute for the high
voltage power supplies to discharge.

Achtung:

Reinigen Sie keinesfalls Emitter-Punkte bei eingeschaltetem
Gerät. Andernfalls kann es zu zusätzlicher Verunreinigung
oder zu Stromschlag kommen. Warten Sie nach dem
Ausschalten des Aerobars eine Minute, damit sich die
Hochspannungs-Netzteile entladen können.

To clean the emitter points and areas around the emitter points,
moisten a cleanroom-compatible swab with the IPA solution, or use
Simco-Ion Emitter Point Cleaner. Gently rotate the swab around the
emitter point until dirt or debris is removed.
Do not alter emitter points in any way. Doing so may void the
warranty.

19-5225-M-01 Rev 2

58

Emitter Point Replacement
Emitter point replacement is recommended every 24 to 36 months,
or when damage or erosion is evident.
To remove emitter points: Use a soft-jawed tool to remove silicon
points. Silicon points are brittle and may break if handled roughly.
When pulling a silicon point out, keep the point straight. Do not
move the emitter point from side to side, or the point may snap.

Figure 15. Removal of Silicon Emitter Point

Clean the area around the socket with a cleanroom-compatible
cloth and IPA solution before inserting new points.
To insert new emitter points: Gently insert and press the new
emitter point into the socket until it is fully seated. Do not push on
the tip of the emitter point.

Chassis Cleaning
Use a cleanroom-compatible cloth moistened with 50% IPA and
50% de-ionized water to wipe down the chassis. Do not use any
cleaners or solvents.
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4.3 Interface Module Maintenance
The only maintenance the Interface Module requires is occasional
cleaning of the chassis.
After removing power from the Interface Module, use a cleanroomcompatible cloth moistened with 50% IPA and 50% de-ionized
water to wipe down the chassis. Do not use any other cleaners or
solvents.
Moisten a cleanroom cloth with the diluted IPA solution. Thoroughly
wipe down the case to remove any accumulated dirt. Change the
cloth frequently to make sure that the dirt is completely lifted.
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4.4 System Adjustment and Calibration
Adjustment and calibration should be performed as a regular part of
installation and maintenance activity.
Refer to Chapter 3: Operation for instructions on adjusting and
calibrating the system.
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5
Specifications
5.1 AeroBar Model 5225
5.2 Parts & Accessories
5.3 Dimensional Drawings
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5.1 AeroBar Model 5225
Model 5225
Input Voltage

24 VAC, 60 Hz, received from the Interface Module

Input Current

Approximately 40 mA/AeroBar, 1W (typ)

Output Voltage

0-20 kVDC, ±10% for each polarity on an individual AeroBar; pos/neg output
levels can be adjusted separately in 0.1% output power resolution

Output Current

<15 µA, current and voltage limited

Control Signal

RS-485 from the Interface Module

Connectors

Telephone-style RJ-11 modular jack receptacle

Regulation

Output and balance stability is achieved by independently regulating the ion
emission current of each polarity at each ionizer

Timing

Precise timing (0-10 sec @ 0.1 sec resolution); LEDs on each bar indicate
the polarity of ion emission

Operating Modes

Bipolar pulsed DC, steady-state DC, or standby

Emitter Points

Single-crystal silicon; replaceable

Maintenance

Annual, semi-annual, or quarterly, depending on process sensitivity and
presence of AMCs in the environment

Ozone

<0.005 ppm (24-hour accumulation)

Operating Env.

Temperature 60-95°F (16-35°C); humidity 40-65% RH, non-condensing

EMI

Below background level

Cleanliness

ISO 14644-1 Class 1 (better than Fed. Std. 209(e) Class 1)

LED Indicators

2 red POS/NEG ION OUTPUT; 1 middle red ALARM/STANDBY; all 3 blink
at once when COMMUNICATION occurs; 2 transmit/receive indicate
communication with an optional IR remote control.

Chassis

Fire-retardant ABS plastic

Required

Interface Module Model 5200-IM6T

Optional

IonMonitor software (p/n 91-5200-SW-V1.0.X; not sensor compatible); AC to
DC converter (p/n 33-5200)

Dimensions

22.4” bar: 2.1H x 1.2W x 22L in. (5.3H x 3.05W x 56.9L mm)
28.4” bar: 2.1H x 1.2W x 28L in. (5.3H x 3.05W x 72.1L mm)
44.4” bar: 2.1H x 1.2W x 44L in. (53H x 30.5W x 112.8L mm)
64.4” bar: 2.1H x 1.2W x 64L in. (53H x 30.5W x 163.6L mm)
84.4” bar: 2.1H x 1.2W x 84L in. (53H x 30.5W x 214.4L mm)
Three lengths for 300 mm EFEM applications available:
35.7” bar: 2.1H x 1.2W x 35.7L in. (53H x 30.5W x 90.7L mm)
55.6” bar: 2.1H x 1.2W x 55.6L in. (53H x 30.5W x 141.2L mm)
75.5” bar: 2.1H x 1.2W x 75.5L in. (53H x 30.5W x 191.8L mm)
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Weight

1.2 lb, (544g), 22” bar

Warranty

Two year limited warranty
SEMI F47
RoHS Compliant

Certifications
Interface Module Model 5200-IM6T
Input Voltage

24 VDC, 1.0A, ±5% via CPC connector from tool or optional adapter
100-240 VAC

Output Voltage

24 VAC to the ionizers

Output Current

Approximately 40 mA per AeroBar

Comm Ports

Ethernet, RS-485, and RS-232 (DB9)

Device Ports

Ports 1-6 can connect up to six AeroBars.

LED Indicators

Green POWER; Red ALARM - reserved for future use; Yellow
COMMUNICATION

Chassis

Aluminum with epoxy-polyester powder coat

Operating Env.

60-95°F (16-35°C); 40-65% RH, non-condensing

Dimensions

2.76W x 2.96H x 12.42L in. (7.0W x 7.5H x 31.5L cm)

Weight

2.6 lb (1.2 kg)

Certifications

RoHS Compliant

IonMonitor Software
Contents

IonMonitor.exe; IonSimulator.exe; IonAccess.DLL Library;
TestIonAccess.exe; Software Developer’s Kit Manual

Requirements

Microsoft Windows XP or 7, CD-ROM drive, available Ethernet port and IP
address or RS-232 port
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5.2 Parts & Accessories
AeroBars
91-5225U-22R

22" Model 5225 AeroBar with 5 ultraclean (silicon) emitter points

91-5225U-28R

28" Model 5225 AeroBar with 7 ultraclean (silicon) emitter points

91-5225U-44R

44" Model 5225 AeroBar with 9 ultraclean (silicon) emitter points

91-5225U-64R

64" Model 5225 AeroBar with 13 ultraclean (silicon) emitter points

91-5225U-84R

84" Model 5225 AeroBar with 17 ultraclean (silicon) emitter points

91-5225U-36R

36" Model 5225 AeroBar with 8 ultraclean (silicon) emitter points; 300
mm EFEM length

91-5225U-56R

56" Model 5225 AeroBar with 12 ultraclean (silicon) emitter points; 300
mm EFEM length

91-5225U-76R

76" Model 5225 AeroBar with 16 ultraclean (silicon) emitter points; 300
mm EFEM length

91-5200-IM6T-V1.X

IM6T Interface Module powered by 24 VDC, supports up to six Model
5225 AeroBar ionizers, does not support sensors

91-5200-SW-V1.X

Software package, requires V1.x version of IM6T

QIG-IM6T-001

Quick Installation Guide for setting up network and/or serial connections
between the Interface Module and the computer

Accessories
24 VDC hardware cable

33-1790-40

100-240 VAC to 24 VDC transformer

33-5200

Flat mounting clips

28-6255

4-inch polycarbonate mounting rods

93-1420

8-inch polycarbonate mounting rods

93-1421

12-inch polycarbonate mounting rods

93-1422

Emitter Point Cleaner

22-1000

2.5 meter/8 foot IEC power cable (US plug)*

25-20660

2.5 meter/8 foot IEC power cable (UK plug)*

25-20710

2.5 meter/8 foot IEC power cable (German Schuko plug)*

25-20735

3 meter/10 foot IEC power cable (US plug)*

25-0670

4.6 meter/15 foot IEC cable (US plug)*

25-0680
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3 meter/10 foot IEC cable (No plug)*

25-0700

AeroBar Installation Kit

93-5200

AeroBar Developer’s Kit Instruction Manual

19-5200IM6T-SW

* IEC cables required only if AC transformer p/n 33-5200 is purchased.

Replacement Emitter Points and Cleaner
22-0365-1

Ultraclean Sleeved (Silicon) Emitter Points, box of 1

22-0365-10

Ultraclean Sleeved (Silicon) Emitter Points, box of 10

22-0365-15

Ultraclean Sleeved (Silicon) Emitter Points, box of 15

22-0365-20

Ultraclean Sleeved (Silicon) Emitter Points, box of 20

22-0365-25

Ultraclean Sleeved (Silicon) Emitter Points, box of 25

22-0365-30

Ultraclean Sleeved (Silicon) Emitter Points, box of 30

22-1000

Emitter Point Cleaner (Box of 50)
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5.3 Dimensional Drawings
Model 5225 Standard Lengths
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Model 5225 300 mm EFEM Application Lengths
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Interface Module Model 5200-IM6T
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6
Warranty & Service
Simco-Ion provides a limited warranty for the AeroBar Model 5225,
Interface Module Model 5200-IM6T, and IonMonitor software
package.
New products manufactured or sold by Simco-Ion are guaranteed
to be free from defects in material or workmanship for a period of
two (2) years from date of initial shipment. Simco-Ion liability under
its new product warranty is limited to servicing (evaluating,
repairing, or replacing) any unit returned to Simco-Ion that has not
been subjected to misuse, neglect, lack of routine maintenance,
Simco-Ionrepair, alteration, or accident. In no event is Simco-Ion be
liable for collateral or consequential damages. Consumable items
such as, but not exclusive to, emitter points, emitter wires, batteries,
filters, fuses or light bulbs are only covered under this warranty if
found defective as received with the new product.
Simco-Ion is in compliance in all material respects with the terms
and conditions of all material permits, licenses and authorizations
which are required under federal, state and local laws applicable to
Simco-Ion and relating to pollution or protection of the environment,
except where the failure to obtain such authorizations could not be
reasonably expected to have a material adverse effect on the
business of Simco-Ion or its customers. Simco-Ion is not aware of
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any conditions, circumstances, activities, practices, incidents, or
actions which could reasonably be expected to form the basis of any
claim, action, suit, proceeding, hearing, or investigation of, by,
against or relating to Simco-Ion, based on or related to the
manufacture, processing, distribution, use, treatment, storage,
disposal, transport, or handling, or the emission, discharge, release
or threatened release into the environment, of any pollutant,
contaminant, or hazardous or toxic substance, material or waste, or
relating to the safety of employees, workers or other persons, other
than such conditions, circumstances, activities, practices, incidents,
or actions that are beyond reasonable knowledge of and control of
Simco-Ion.
THIS WARRANTY IS THE ONLY WARRANTY MADE BY SIMCOION WITH RESPECT TO THE GOODS SOLD UNDER THIS
AGREEMENT. THERE IS NO OTHER WARRANTY, EXPRESS
OR IMPLIED, INCLUDING ANY IMPLIED WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. SIMCO-ION FURTHER DISCLAIMS ANY
WARRANTY, EXPRESS OR IMPLIED, LIABILITY OR SUPPORT
OBLIGATION FOR ALTERED, DAMAGED OR MODIFIED
SOFTWARE OR ANY PORTION OF THE SOFTWARE
INCORPORATED WITH OR INTO THIRD-PARTY PRODUCTS
OR PRODUCT PROBLEMS CAUSED BY CUSTOMER'S
NEGLIGENCE, ABUSE OR MISAPPLICATION OR USE OF THE
PRODUCT OTHER THAN AS SPECIFIED BY SIMCO-ION.
Simco-Ion shall not be liable for any incidental, special, indirect or
consequential damages, losses or expenses directly or indirectly
arising from the sale whether in contract, tort, or any other legal
theory. In any event, Simco-Ion liability hereunder is expressly
limited to the repair or replacement (at Simco-Ion's option) of nonconforming goods or, at Simco-Ion's election, to the repayment or
crediting to Buyer the purchase price of such goods.
Claims/Notice of Defects
Failure of the Buyer to object in writing to any merchandise shipped
to it by Simco-Ion within 30 days after receipt thereof will constitute
complete acceptance by Buyer of such merchandise. Rejected
material must be returned to Simco-Ion within 45 days after receipt
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and with prior authorization from Simco-Ion. Simco-Ion may (at its
option) recondition or replace the rejected material to meet Buyer's
specifications within a reasonable time period after receipt. Claims
for shipping damage must be made with the carrier. All products
must be returned in the same packing conditions in which it left
Simco-Ion manufacturing location(s) (anti-static rails and boxes,
adequately protected, etc.). Buyer must pay return shipping.
Confidential Information
All drawings, diagrams, specifications and other materials furnished
by Simco-Ion and identified as confidential, or information which the
Buyer knows or has reason to know is confidential, proprietary or
trade secret information of Simco-Ion, relating to the use and
service of articles furnished hereunder and the information therein,
are proprietary to Simco-Ion. Buyer may not reproduce or distribute
such materials except to buyer's employees who may use the
articles as part of their duties.
Customer agrees that it will take all reasonable measures to
maintain the confidentiality of all confidential information in its
possession or control, which will in no event be less than the
measures it uses to maintain the confidentiality of its own
information of equal importance. Accordingly, Simco-Ion will be
entitled to preliminary and permanent injunctive relief and other
equitable relief for any breach of this warranty.
Buyer further acknowledges and agrees that the sale of products to
Buyer does not convey any license express or implied, and Buyer
shall not, manufacture, modify, reverse engineer, duplicate,
otherwise copy or reproduce any of the products or any part thereof.
Simco-Ion will treat drawings, specifications or data furnished by
Buyer as confidential, when identified as such, in connection with
this purchase.
Simco-Ion Software; Restricted License
The Simco-Ion products consist of certain proprietary hardware (the
"Hardware") and certain proprietary software (the "Software").
Simco-Ion hereby grants to Buyer or Buyer's end user, a limited,
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non-transferable (without the right to distribute or sublicense), nonexclusive right and license to use the Software solely in conjunction
with such Hardware during the term of this Agreement. Buyer
receives no title or ownership rights to such Software. Except for the
license granted in this Section K, all right, title and interest in the
Software shall remain the exclusive property of Simco-Ion or its
licensors. This Agreement does not entitle Buyer to the receipt or
use of, or access to, Software source code or any right to reproduce
the Software or any related documentation, and Buyer agrees that
it shall not decompile, disassemble, compile or reverse engineer the
Software or otherwise attempt to gain access to the Software
source code, except with sample applications and integration tools
that are provided with source code to assist in customer integration.
To obtain service under this warranty, please contact Simco-Ion
Technical Support at techsupport@simco-ion.com or (510) 2170470.
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Appendix A
Setting IonMonitor
Options
A1 About the Startup Configuration File
A2 Editing IonMonitor Options
A3 Reloading the Configuration File
A4 Contents of the Configuration File
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A1 About the Startup Configuration File
When IonMonitor starts up, it looks in its directory for file
“IonMonitor.cfg” to preload settings for connections, GUI options,
interface module options, and default ionizer settings.
If the configuration file is present and can be opened, then settings
in it are read in and placed in the Edit > Options dialog, where they
can later be modified and saved back to the configuration file.
If the startup configuration file is missing or cannot be opened, a
message appears in the session history window identifying the
problem and uses built in settings for all options.

Note:

If any field in any of the options tabs has a validation problem,
then no changes will be saved. This is also true when settings
are saved to the startup configuration file - either all settings
are valid and all are saved, or no settings are saved.

Hinweis:

Wenn in einem der Options Tabs ein Feld ein Validierung
Problem hat, dann werden keine Änderungen gespeichert.
Dies gilt auch für Einstellungen die im Startup Configuration
File abgelegt werden. Entweder alle Einstellungen sind gültig
und werden gespeichert, oder es werden keine Einstellungen
gespeichert.

Any problems encountered with the contents of the file will generate
entries in the session history window. Problem settings are reported
and then skipped over - thus, all valid settings are actually applied.
The startup configuration file can be customized to be something
other than the default “IonMonitor.cfg”. To use a non-default startup
file, name it on the command line when starting up IonMonitor. The
named file either has to be in the IonMonitor installation directory, or
the name has to be fully qualified with its complete path.
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A2 Editing IonMonitor Options
From the Edit menu, select Options.

The following menus are available:
• Connection options
• Interface Module options
• Default Ionizer Setting options
Each menu is described below.

Connection Options
See the Network Configurations section in Chapter 2: Installation for
information about changing these options.

Connection Options Menu
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Interface Module Options

Interface Module Options Menu

• Synchronize all ionizers every 60 minutes: To enable a
synchronization every 60 minutes, check the box. (Time is not
editable.)
• Automatically refresh the GUI periodically: This is an autorefresh for the IonMonitor interface. No matter what the time is
set to, you can still refresh at any time by clicking the Refresh
GUI Now button.
In addition to refreshing the GUI, after every refresh the
IonMonitor writes the file “IonData.txt” in its installation
directory. The IonData.txt file contains all settings for all
ionizers that were connected to ports at the moment that the file
was written. Data in IonData.txt is written in Simco-Ion file/
command format.
• Polling period for IonAccess to IM6T (5-5000 seconds): Set
the time for how often you want the IonMonitor software to poll
the IM6T for information about AeroBars.
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• Communications logging level: This allows you to select the
amount of information you want to view in the session history
area in IonMonitor. In addition to displaying the information in
IonMonitor, a log file named “IonMonitor.log” is automatically
opened and filled with time-stamped information. The amount
of information in this file depends on the setting specified:
•
•
•
•
•

Nothing: no log
Errors: only errors are logged
Warnings: only warnings are logged
Info: communication activity information
Everything: all information is logged

Note:

At the Everything logging level, with a 5-second IonAccess
polling period and 4 or more ionizers in ports, the log file will
grow at about 2 megabytes per hour. Keep this in mind when
setting the logging level! Logging only Errors or Warnings is
recommended for practical applications.

Hinweis:

Bei Logging-Level "Everything", mit einer 5-Sekunden
IonAccess Pollingzeit und 4 oder mehr angeschlossenen
Ionisatoren, wird die Log-Datei auf etwa 2 Megabyte pro
Stunde anwachsen. Beachten Sie dies bei der Einstellung der
Logging-Level! Für praktische Anwendungen wird lediglich
das Logging von Fehler oder Warnungen empfohlen.

• Write configuration info in file IonMonitor.cfg: Clicking this
button saves the Interface Module option settings into the
startup configuration file, making these settings the permanent
default.
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Default Ionizer Settings

Default Ionizer Settings Menu

• Op mode: Choose Pulse or Steady as the default operation
mode for AeroBars. (Pulse is recommended.)
• Output, Alarm, On, Off: Default values for positive and
negative output, alarm, and on or off values. It is useful to set
default values for these settings that match your environment
needs, which allows the instant application of desired settings
to be applied to new AeroBars by clicking the Use Default
Ionizer Values button.
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A3 Reloading the Configuration File
After starting IonMonitor, at any time you can reload the same
startup configuration file that you started with. To do this, go to File>
Reload Startup Configuration File. A reload restores options to
whatever is specified in the file.
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A4 Contents of the Configuration File
Startup configuration files use the file/command format. The
contents of a typical IonMonitor configuration file are:
#
#
connection settings
#
connect mode=TCP/IP ipAddress=192.168.18.100 port=10001
#
#
GUI refresh settings
#
set autoRefresh=on autoRefreshPeriod=8
#
#
interface module settings
#
set sync=1 pollPeriod=7
set logging=2
#
#
default ionizer settings
#
set Port=0 Pulse=0
set Port=0 PosOut=444 PosAlrm=11 PosOn=40 PosOff=4
set Port=0 NegOut=666 NegAlrm=17 NegOn=60 NegOff=6
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Appendix B
Emitter Settings Using
the 5572 Remote Control
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B1 Setting Emitter Addresses
These device addresses are handled by the IM6T. The
AeroBar's address should not be changed from its default
address of 01 when the AeroBar is used with the IM6T.
Emitters are shipped with factory-set addresses. These instructions
refer to changing the factory-set address.
1. Turn on the Remote Control while holding down any button. A
password prompt will appear.
2. Enter in the following password: Esc, Down, Up, Select,
Select, Select, Select.
3. Use the Up or Down button to scroll to the Address item. Press
Select.
4. Use the Up or Down button to change the address number
while pointing the remote control directly at the middle LED on
the emitter. Stop at a desired address number. The address is
sent to the emitter immediately. Press Esc to exit. The Emitter
address will appear as a two-digit number, followed by the
Controller address in parentheses
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B2 Setting Pulsed DC, Steady-state DC,
or Standby Mode
The factory default mode is set to pulsed DC mode, at 1.0 second
on, 0.2 seconds off.
1. Hold down any button while turning on the remote control. A
password prompt will appear.
2. Enter the following password: Esc, Down, Up, Select, Select,
Select, Select.
3. Use the Up or Down button to reach the OpMode item. Press
Select.
4. Point the remote control directly at the LEDs on the Emitter and
use the Up or Down button to select the operation mode
(Standby, Pulsed, or StdySDC). Press Esc to exit.

Setting Timing

The factory default is 1.0 second on, 0.2 seconds off.
1. Holding down any button while turning on the remote control. A
password prompt will appear.
2. Enter the following password: Esc, Down, Up, Select, Select,
Select, Select.
3. Use the Up or Down button to reach the desired PosOn,
PosOff, NegOn, or NegOff item. Press Select.
4. Use the Up or Down button to change the timing parameter.
Press Esc to exit from the change action.
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B3 Setting Output Levels
The factory default output level setting is 30% (approximately ±7 kV
to ±8 kV).
1. Use the Up or Down button to reach the PosOut or NegOut
item. Press Select.
2. Use the Up or Down button to adjust the output level accordingly. Press Esc to exit from the change action.
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B2 Setting Alarm Levels
The default alarm percentage value is 25% of the output level. For
proper maintenance and performance, alarm percentage should be
set to 50-75%.
1. Hold down any button while turning on the remote control. A
password prompt will appear.
2. Enter the following password: Esc, Down, Up, Select, Select,
Select, Select.
3. Use the Up or Down button to reach the PosAlrm or NegAlrm
item. Press Select.
4. Point the Remote Control Model 5572 directly at the center
Emitter LED and use the Up or Down button to change the
alarm level.
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Notes
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Notes
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